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Delivery specifications Digital Advertising 

 

Standard formats 

 General rules for material submission  

- All advertisements on the Sanoma Media network must be clearly identifiable to users as 

advertisements. 

- Sound is only allowed in advertisements when activated with a mouse click and if the linked file 

includes an easy-to-locate ‘Stop’ or ‘Pause’ button.  

Allowable formats on the Sanoma Media network 

The following formats are available on Sanoma Media’s network. 

Full banner: 468x60 pixels, 40kb max 

Half banner: 234x60 pixels, 40kb max 

Button 180: 180x150 pixels, 40kb max 

Button 150: 150x150 pixels, 40kb max 

Large rectangle: 336x280 pixels, 40kb max 

Medium rectangle: 300x250 pixels, 40kb max 

Skyscraper: 120x600 pixels, 40kb max 

Leaderboard: 728x90 pixels, 40kb max  

For other formats (layers, advertorials, etc.), we refer you to the relevant pages on our website. 

The various types of creatives: 

1. Flash banner 

- Formats as listed above 

- Maximum file size of 40kb 

- Deliver as SWF, Flash 8, ActionScript 2 

- With clickTAG, embedded using the following code sequence: 

on (release) { getURL(_root.clickTag, "_blank"); }  

- Include GIF file for the banner 

- Active URL 

- The properly formatted material must be delivered to us at traffic@sanomamedia.nl no later than 

3 days before the start of the campaign, including the order code. 

2. Standard images: GIF, JPG and PNG 

- Formats as listed above 

- Maximum file size of 40kb 

- The properly formatted material must be delivered to us at traffic@sanomamedia.nl no later than 

3 days before the start of the campaign, including the order code. 

3. External JavaScript/ad server tags 

- Formats as listed above 

- Content must be functional and link to the right landing page. 

- Please include clear instructions with regard to where, if necessary, in the script we can insert 

macros for our ad management system.. 

- The properly formatted material must be delivered to us at traffic@sanomamedia.nl no later than 

3 days before the start of the campaign, including the order code. 

Contact 

Do you have any material submission queries? If so, please contact our Traffic department, at 

traffic@sanomamedia.nl or on +31-(0)20-840-4540. 
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Flash 

These delivery specifications are designed for Flash 8. What follows is a description of how to 

deliver Flash banners. It is important that you read these instructions carefully, as the procedure 

for creating a link could be different to what you are used to.  

The explanation on how to insert a variable into your Flash banner follows below. This variable is 
inserted into your Flash movie where you would normally place the URL link. Once the campaign is 

up and running, our banner management system replaces this variable with a URL that we can use 
to see the click history. 

How do I deliver my Flash movie? 
> First, create a button. You do this by drawing a box in a new layer. 

> It is important that this ends up being the top layer. 

> Highlight the entire box and go to the menu: Modify > Convert to Symbol or use the F8 shortcut 
key. 

> In the window that now appears, click on the circle to select the Button option and then click OK: 

 
  
> You will then make this new button symbol invisible by going to the Colour menu in the 

Properties panel, and by selecting the Alpha option and adjusting the Alpha value to 0%. 
 

 
 

Now you have a button, but it does not yet have an action linked to it.  
> To do this, first you must select the button you have just created. 

> Then go to Window > Development Panels > Actions 
 

 
  

> Continue on to the next page 
> The Actions Panel now opens 

> Copy the following code into the white box on the right: 
 

on (release) { 
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getURL(_root.clickTag, "_blank"); 

} 

  

 
 

How do I publish my Flash movie? 

> Go to the File menu and click on Publish Settings. 
 

 
  
> The Publish Settings panel will open. 

> Click on the Formats tab. You will be shown a list of options, including Flash, HTML, GIF, etc. 
> Tick the boxes for Flash (.swf) and HTML (.html). 

> When you then click on the Publish button, two files will be created. One HTML and one SWF file. 

> We need those HTML and SWF files, along with the URL the banner will point to. 

> We also like to have the FLA files and fonts used, so that we can act quickly in the event of any 

technical problems and possibly recompile the movie. 
 

Contact 
Do you have any material submission queries? If so, please contact our Traffic department, at 

traffic@sanomamedia.nl of 020 840 4540. 
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Expandable creatives 

Expandables consist of two files: the original format and 
the expanded panel. 

- A separate GIF file must be delivered for each of these files, along with any extras. 
- If Flash is used to create them, be sure to use Version 8 or older. 

- Max weight per file for Flash: 40kb. GIF Backup (or JPG): 40kb. 
- The buttons that link to the advertiser’s website must contain the following action: on (release) { 

getURL(_root.clickTag , "_blank"); } 
- PLEASE NOTE: If there is more than one target page, replace “_root.clickTag” in the code above 

with “_root.clickTag1”, “_root.clickTag2”, etc.  

 

- Banner (468x60, 40kb),  
expandable format: 468x180,  

100kb (expands downward) 
 

- Skyscraper (120x600, 40kb),  

expandable format: 360x600,  

100kb (depending on placement of base format) 

 
- Medium rectangle (300x250, 40kb), 

expandable format: 600x250, 
100kb (expands to the right and left) 

 

- Large rectangle (336x280, 40kb),  

expandable format: 672x280,  
100kb (expands to the right and left) 

 
- Leaderboard (728x90, 40kb), 

expandable format: 728x270, 
100kb (expands downward) 

 
The expandable portion includes the height or width of the base format. An expandable creative 

always comprises 2 parts: the base format and the expandable format (width x height).  

 
Sound 

Sound is permitted on click, but it must stop immediately when the user moves the mouse outside 
the borders of the expandable portion. 

 
Note: Sound is only permitted on NU.nl if the visitor has the option of activating it using a 

soundbutton. This means you are not permitted to automatically play sounds in any form 
whatsoever. 

 
Note: To prevent other layers from showing through the expandable, be sure to use the following 

parameters: 
w_mode = opaque 

z-index for the base format = z-index=100 
Set the z-index for the layer as high as possible (z-index=999999999) 

  
Contact 

Do you have any material submission queries? If so, please contact our Traffic department, at 

traffic@sanomamedia.nl or 020 840 4540. 
IMX display delivery specifications  

All banner formats must be delivered for IMX. We highly recommend multiple creatives per banner 
format.  

 

Type of banner Format Max weight (kb) 

Button  120x120 40 

Skyscraper  120x600 40 

Half banner  234x60 40 

Banner  468x60 40 
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Large rectangle  336x280 40 

Leaderboard  728x90 40 

Medium rectangle   300x250 40 

 

> Only JPG, GIF and initial Flash and HTML banners will be accepted  

> No 'fake’ HTMLs or ‘fake functionalities’  
> No sound  

> No video 
> Maximum of 15 sec. animation/loops  

> It must already be obvious in the banner which advertiser is sending the message out  
> No crossed out text  

> No fast repetition or blinking 
> Banners should contain a call to action 

 
IMX text delivery specifications 

> Title (20 characters)  

> Description (70 characters)  

> URL display (35 characters)  
> URL destination (255 characters)  

> Icon, 50x50 pixels (JPG/GIF) 
 

Contact 

Do you have any material submission queries? If so, please contact our Traffic department, at 

trafficimx@sanomamedia.nl or 020 840 4540. 

  



Sanoma Media Netherlands B.V.  

Streaming video 

  

Streaming video on the Sanoma Media network  

 
> Flash 8, FLV (Flash Video) specifications  

Since the release of Flash Professional 8, it has become very easy to publish video film clips that 
can be seen by a vast majority (98%) of internet users. Since this method has become the 

standard for showing videos on the web, we do not support any other (streaming) video formats. 
This is primarily because we do not want to make our users download plug-ins (other than the 

Flash player) to see the advertisements. The stipulations listed below have been designed by us to 

ensure that our visitors’ internet experience remains as enjoyable as possible. 

 
Stipulations for delivering in-stream videos 

> Playing time: 15 seconds 
> File delivery format: FLV + target URL 

> Optimised to: 640x360 

> Companion: 336x280 (general delivery specifications) 

> Upon request, we can also convert and encode files (MOV, AVI, MPG, MPEG and 3GP) to FLV 

> Suggested measurement points (onStart and onEnd) 
> Files can only be delivered through Eyeblaster if a direct URL source is delivered for the FLV 

 
Important links 

> For more information about encoding FLV (Flash Video), visit: 

http://www.adobe.com/devnet/flash/video.html. 

> For more information on the Sorenson Squeeze plug-in, visit: 
http://www.sorensonmedia.com/ 

 
Contact 

Do you any material submission queries? If so, please contact our Traffic department, at 
traffic@sanomamedia.nl or 020 840 4540. 

  



Sanoma Media Netherlands B.V.  

Rich media 

Rich media on NU.nl General  
 

General website criteria 
NU.nl strongly favours white or light-coloured backgrounds for creatives; endeavouring to create a 

style that fits nicely with the website’s design. NU.nl aims for simplicity, ease and clarity when 
communicating with its audience and is considered to be ‘cordial’. Advertisements should adhere 

closely to these core values. Experience has taught us that this is what visitors value most. All 
creatives, including animations, will be evaluated for their effect on the site’s usability and 

performance. Backgrounds and animations must therefore load quickly. In addition, creatives must 

correspond to the clean-cut look of NU.nl. Extremely busy creatives, in terms of either animation or 

colour use, will not be allowed on the front page.  
  

Radical on Front Page/General 
Examples: 

http://clients.adrime.com/files/campaigns/4947015899/13585/NL_nu.nl_beta_index.html 

http://clients.adrime.com/files/campaigns/6730510739/14259/NL_nu.nl_beta_index.html 

 

- Strong preference for white background. If different colours are used, it will be determined 
whether this interferes with the readability of site content. The creative will be placed 7 pixels from 

the left-hand menu and the right-hand column.  
- Animation: 10 seconds  

- Animation cap: 1/hour  

- Additional animations ‘after click’  

  
Radical Sections 

Example: 
http://clients.adrime.com/files/campaigns/8407413117/13724/NL_nu.nl_katern_beta_index.html 

  
Specifications for Front Page/General  

  
NU.nl Skybox Home 

Examples: 

http://clients.adrime.com/files/campaigns/1098516359/13779/NL_nu.nl_beta_index.html 
  

Formats to be produced: 
- Leaderboard Controller: 728x90 

- Header: 735x90 
- Right layer: 120x850 

- Button layer: 185x150 
  

Specifications: 
- SWF 150kb max. 

- GIF backup 50kb max.  
- Animation is limited to a maximum of 10 seconds. 

- Make sure the animation is not too busy, so that the advertisement is not disruptive.  
 

The preferred background colour is white.  
- Always deliver a second static version (Flash/GIF, no animation).  

- Video 2.2mb max. (FLV F4V) optional. Max video playing time of  30 seconds (initiated by user).  

- Sound must be user-initiated by click.  
- Make sure that CPU usage does not exceed 50% on a dual-core processor.  

- Create a sample version first for editorial approval; this is a requirement.  
 

Skybox on NU.nl Front Page/General 
- White background is preferred. If different colours are used, it will be determined whether this 

interferes with the readability of site content.  

- Animation: 10 seconds 

- 7 pixels from the NU.nl menu bars 
- Additional animation ‘after click’  

- The final material must be delivered at least 5 business days prior to going live. 
- Make sure to always create a second static version (no animation; e.g., the final frame of the 
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animated version). The animated version has a frequency cap of once per hour. The static version 

will be shown for all other contacts. 

 

Skybox on NU.nl Other Sections 
- Animation: 10 seconds 

- More possibilities, such as different background colours  
- 7 pixels from the NU.nl menu bars  

- Additional animation ‘after click’ 

- The final material must be delivered at least 5 business days before going live. 

- Make sure to always create a second static version (no animation; e.g., the final frame of the 
animated version). The animated version has a frequency cap of once per hour. The static version 

will be shown for all other contacts. 
 

Startpagina.nl Skybox 

Example: 

http://clients.adrime.com/files/campaigns/1286363603/4694/NL_startpagina.nl_index.html 
 

Formats to be produced: 

- NuSkyboxKaternSynced_468x60 (controller)  
- NuSkyboxKaternSynced_480x60 (layer)  

- NuSkyboxKaternSynced_120x600 (layer)  

- GIF backup 468x60  

 
Specifications: 

- SWF 150kb max.  
- GIF backup 50kb max.  

- Animation is limited to a maximum of 10 seconds. 
- Make sure the animation is not too busy, so that the advertisement is not disruptive. 

- You must limit the number of colours used. 
- Always deliver a second static version (Flash/GIF, no animation).  

- Video 2.2mb max (FLV F4V) optional. Running time: 30 seconds max (user-initiated).  
- Sound must be user-initiated by click. 

- Make sure that CPU usage does not exceed 50% on a dual-core processor.  

- It is important to deliver a sample version first for editorial approval.  

- The final material must be delivered at least 5 business days before going live. 

- Make sure to always create a second static version (no animation; e.g., the final frame of the 
animated version). The animated version has a frequency cap of once per hour. The static version 

will be shown for all other contacts. 
 

Flash templates: 
The creative can be made in the content layer. The template already contains a Close Window 

button and the clickTAG variable. 
 

NU.nl Radical Section  
Examples: http://clients.adrime.com/files/campaigns/1343418070/5688/NL_nu.nl_index.html, 

http://clients.adrime.com/files/campaigns/1142523156/5013/NL_nu.nl_index.html 
 

Formats to be produced: 

- Banner 471x160  

- Skyscraper 120x600  

- Button 120x120  
- Left skin 640x1500 (for all resolutions), animated 

- Right skin 640x1500 (for all resolutions), animated 
- Left skin 640x1500 (for all resolutions), static 

- Right skin 640x1500 (for all resolutions), static 
- GIF backups for 468x60, 120x120, 120x600. The 468x60 controller functions as a fixed position 

from which all formats are served. 
 

Specifications: 
- SWF 150kb max.  

- GIF backup 50kb max.  

- Animation is limited to a maximum of 10 seconds. (Looping is allowed for the banner positions 

but not the skin.) 
- Make sure the animation is not too busy, so that the advertisement is not disruptive.  You must 
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limit the number of colours used. The preferred background colour is white.  

- Always deliver a second static version (Flash/GIF, no animation). 

- Bear in mind that many people have their resolution set to 1024x768. Make sure that logos and 

CTAs are visible in this area.  
- Make sure that CPU usage does not exceed 50% on a dual-core processor.  

- Video 2mb max (FLV F4V). Maximum running time of 30 seconds (user-initiated).  
- Sound must be user-initiated by click. 

- It is important to deliver a sample version first for editorial approval.  

 

Important: 
- Final material must be delivered at least 5 business days before going live.  

- Make sure to always create a second static version (no animation; e.g., the final frame of the 
animated version). The animated version has a frequency cap of once per hour. The static version 

will be shown for all other contacts. 

- Both versions must be approved by the editorial team at NU.nl. Send a preview of both versions 

(animated and static) of the radical to your contact. Be sure to have a final preview ready at least 
7 business days before the start of the campaign.  

 

Kieskeurig.nl Roof Ad 
Example: 

http://clients.adrime.com/files/campaigns/1200864866/8671/NL_kieskeurig_subpage_index.html 

Formats to be produced: 

- Roof ad 850x280  
- Rectangle 336x280  

 
Specifications: 

- SWF 150kb max.  
- GIF backup 50kb max. 

- Animation is limited to a maximum of 10 seconds. (Looping is allowed for the banner positions 
but not the skin.)  

- Video 2.2mb max. (FLV F4V) optional. Maximum running time of 30 seconds (user-initiated).  
- Sound must be user-initiated by click. 

- Make sure that CPU usage does not exceed 50% on a dual-core processor. 

- It is important to deliver a sample version first for editorial approval.  

  

Important: 
- Final material must be delivered at least 5 business days before going live.  

Flash templates 
The creative can be made in the content layer. The template already contains a Close Window 

button and the clickTAG variable. 
 

Autoweek Radical 
Example: 

http://clients.adrime.com/files/campaigns/1217236310/5212/NL_autoweek.nl_index.html 
Formats to be produced: 

- Leaderboard 728x90  
- Rectangle 336x280  

- Left skin 600x1200 (for all resolutions), animated  

- Right skin 600x1200 (for all resolutions), animated 

- Left skin 600x1200 (for all resolutions), static 

- Right skin 600x1000 (for all resolutions), static 
- GIF backups for 728x90, 336x280  

 
Specifications: 

- SWF 150kb max.  
- GIF backup 50kb max.  

- Animation is limited to a maximum of 10 seconds. (Looping is allowed for the banner positions 
but not the skin.)  

- Make sure the animation is not too busy, so that the advertisement is not disruptive. You must 
limit the number of colours used. The preferred background colour is white. 

- Always deliver a second static version (Flash/GIF, no animation). 

- Bear in mind that many people have their resolution set to 1024x768. Make sure that logos and 

CTAs are visible in this area.  
- Make sure that CPU usage on a dual-core processor does not exceed 50%.  
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- Video 2.2mb max. (FLV F4V) optional. Maximum running time of 30 seconds (user-initiated). 

- Sound must be user-initiated by click. 

- It is important to deliver a sample version first for editorial approval.  

 
Important: 

- Material must be delivered at least 5 business days before going live. 
- Always deliver a second static version (Flash/GIF, no animation). 

- Both versions must be approved by the editorial team. Send a preview of both versions 

(animated and static) of the radical to your contact. Be sure to have a final preview ready at least 

7 business days before the start of the campaign.  
 

Flash templates: 
The creative can be made in the content layer. The template already contains a Close Window 

button and the clickTAG variable. 

 

NU.nl Homepage Radical 
Examples: http://clients.adrime.com/files/campaigns/1343418070/5688/NL_nu.nl_index.html, 

http://clients.adrime.com/files/campaigns/1142523156/5013/NL_nu.nl_index.html, 

http://www.easyconcepts.com/demo/eyeblaster/clients/nl/sanoma/nu/radical_hm/ 
 

Formats to be produced: 

- Full banner 468x60  

- Skyscraper 120x600  
- Button 120x120  

- Left layer 800x1500 (for all resolutions), animated 
- Right layer 800x1500 (for all resolutions), animated 

- Left layer 800x1500 (for all resolutions), static 
- Right layer 800x1500 (for all resolutions), static 

- GIF backups for 468x60, 120x120, 120x600  
 

Specifications: 
- SWF 150kb max.  

- GIF backup 50kb max.  

- Animation is limited to 10 seconds; looping allowed for banner positions, not the layers.  

- Make sure the animation is not too busy, so that the advertisement is not disruptive. You must 

limit the number of colours used. The preferred background colour is white.  
- Always create a second static version for the lace layers (no animation).  

- Bear in mind that many people have their resolution set to 1024x768. Make sure that logos and 
CTAs are visible in this area.  

- Make sure that CPU usage does not exceed 50% on a dual-core processor. Video 2.2mb max. 
(FLV F4V) optional. Maximum running time of 30 seconds (user-initiated). 

- Sound must be user-initiated by click. 
- It is important to deliver a sample version first for editorial approval.  

 
Important: 

- The final material must be supplied 5 business days prior to going live.  
- Always deliver a second static version of the side layers (no animation; e.g., final frame of the 

animated version). The animated version will be shown only once per hour per visitor. The static 

version will be shown for all other contacts. 

- Both versions must be approved by the editorial team at NU.nl. Send a preview of both versions 

(animated and static) of the radical to your contact. Be sure to have a final preview ready at least 
7 business days before the start of the campaign.  

 
Corner ad 

- When the page is first called up: Auto expansion for a maximum of 4 seconds, then retracts 
- Dimensions of corner ad in expanded form:597x406 pixels 

- Retracted dimensions: 120x120 pixels  
- Close button: Yes 

- Sound: Yes; On click only  
- Video: Yes; Auto play 

- Retracts from all directions upon mouse-out 

- CPU load: no more than 20% 

- Will be served through the leaderboard via a pixel with no supplementary creative. 
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Floor Ad 

Example: 

http://www.easyconcepts.com/demo/eyeblaster/clients/nl/sanoma/nu/floorad/ 
Retracted status 

Background width: 100% 
Height: 60 pixels 

Middle section 

Width: 600 pixels max 

Height: 90 pixels max 
Click on the image to see larger version.  

Expanded status 
Width: 600 pixels (middle section) 

Height: 450 pixels max  

 

Other specifications: 
- Use of the site logo, colours or style is not permitted 

- Sound can only be played if user-initiated by clicking on a Play/Pause or Volume Control button 

- Floor Ad expands with mouse-over, with a delay of 0.7 seconds 
- Floor Ad retracts with mouse-out 

- GIF backup: 100kb max, frame  

- Rate: 30fps max 

- Animation: 15 sec max  
- Click tracking: Use the standard clickTAG functionality.  

- The Close button must be clearly visible. 
- The final material must be delivered at least 5 business days before going live. 

 
Billboard Women’s Titles 

- Format 900x250, 50kb max, otherwise redirects 
- Animation allowed, so provide SWF for sound – on click, as always 

- The creative is served from the 1x1 Master and receives the 728x90 as companion, for which a 
transparent pixel must be embedded. 

- When launched in the 5 focus titles, this will have to be split into 2 separate ad lines: 1 for Viva 

and 1 for Vrouwonline, Margriet, Libelle & Styletoday. The campaign will therefore have to be 

distributed per ad line according to availability. 

 
Viva Radical  

- CPU load 50% max  
- The creative must fit in with the site’s image. The creative must be approved by the site manager 

for Viva.nl. The editorial team reserves the right at all times to request changes to be made if it 
does not conform to the site’s image. The editorial team reserves the right at all times to reject a 

creative if this does not conform to the site’s image. Deliver content for editorial approval at least 5 
days in advance. Once approval has been granted, no more changes are allowed after the creative 

goes live. If the creative is delivered past the due date, it will no longer go live and a new date will 
be arranged.  

- There are two set colour palettes to choose from:  
- Black: #000000 Red # ed1c24 Green # 8cc63f  

- Blue # 16c1f3 Pink # ec008c White # ffffff  

- Note:  

- o The placement of the Viva logo and banner/leaderboard are static (not flexible)  

- o Image is fixed on the right, with a border  
- o Image is fixed in the background (does not scroll); the visible height of the background image 

can vary per screen, depending on resolution  
- o No deviation is allowed from the colours listed above  

- o The first 260 pixels (viewed from the left) are always 100% uni in one of the above-listed 
colour combinations  

 
Radical Fashionchick 

- Based on a screen resolution of 1280x1024 pixels. 
- Top 1264x100, 130 wide on both sides to the bottom of the page.  

- The creative will be served through the leaderboard position and a separate Large Rectangle, 

336x280, must be delivered. 

- The creative must be static, so no animation, except for the rectangle, which may be a regular 
rectangle.  
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Rich Media for Women’s Sites 

Rich Media Libelle.nl 

richmedia Libelle.pdf 
 

Rich Media Margriet.nl 
richmedia margriet.pdf 

 

Rich Media Styletoday.nl 

Richmedia Styletoday.pdf 
  

Rich Media Viva.nl 
Richmedia viva.pdf 

  

Rich Media Vrouwonline.nl 

richmedia vrouwonline-opmerkingen.pdf 
  

Contact 

Do you have any material submission queries? If so, please contact our traffic department, at 
traffic@sanomamedia.nl or 020 840 4540. 
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Flash for multiple links 

These delivery specifications are designed for Flash 8. It is important that you read these 
instructions carefully, as the procedure for creating a link could be different to what you 

are used to.  
 

The explanation for how to insert a variable into your Flash banner follows below. This variable is 
inserted into your Flash movie where you would normally place the URL link. Once the campaign is 

up and running, our banner management system replaces this variable with a URL that we can use 
to see the click history. 

 

How do I deliver my Flash movie? 

> First, create a button. You do this by drawing a box in a new layer. 
> It is important that this ends up being in the top layer. 

> Highlight the entire box and go to the menu: Modify > Convert to Symbol or use the F8 shortcut 
key. 

> In the window that now appears, click on the circle to select the Button option and then click OK: 

 

 
  
> You will then make this new button symbol invisible by going to the Colour menu in the 

Properties panel, and by selecting the Alpha option and by adjusting the Alpha value to 0%.  
 

 
  

Now you have a button, but it does not yet have an action linked to it.  

> To do so, first you must select the button you have just created 

> Then go to Window > Development Panels > Actions 
  

 
 
> Continue on to the next page 

> The Actions Panel now opens 
> Copy the following code into the white box on the right: 

on (release) { 

getURL(_clickTag1, "_blank"); 
} 
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For subsequent buttons use: 

on (release) { 

getURL(_clickTag2, "_blank"); 

} 
on (release) { 

getURL(_clickTag3, "_blank"); 
} 

on (release) { 

getURL(_clickTag4, "_blank"); 

} 
on (release) { 

getURL(_clickTag5, "_blank"); 
} 

Etcetera 

 

How do I publish my Flash movie? 
> Go to the File menu and click on Publish Settings. 

 

 
  

> The Publish Settings panel will open. 
> Click on the Formats tab. You will be shown a list of options, including Flash, HTML, GIF, etc. 

> Tick the boxes for Flash (.swf) and HTML (.html). 

> When you then click on the Publish button, two files will be created. One HTML file and one SWF 

file. 

> We need those HTML and SWF files, along with the URL the banner points to. 
> We also like to have the FLA files and fonts used, so that we can act quickly in the event of any 

technical problems and possibly recompile the movie. 
 

Contact 

Do you have any material submission queries? If so, please contact our Traffic department, at 

traffic@sanomamedia.nl or 020 8404540. 
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Advertorials 

 

Advertorial on NU.nl 

- Advertorial format: 420x187 pixels, GIF/JPG/PNG, 50kb max 
- Image: 120x120 pixels contained in the advertorial 

- Typeface: Trebuchet  
- Background: White 

- Advertisement bar & border: Blue, colour code #e1eaf9 

- Header: 30 characters max  
- Body: 200 characters max  

 

Download the Photoshop document for advertorials at NU.nl to use as a template for creating the 
advertorial. You must deliver the finished document as a JPG file. 

  
Advertorial on NUzakelijk.nl 

- Advertorial format: 336x200 pixels, GIF/JPG/PNG, 50kb max 

- Image: 90x90 pixels contained in the advertorial  

- Typeface: Trebuchet  

- Background: White 
- Header: 30 characters max 

- Body: 200 characters max 
 

 Download the Photoshop document for advertorials at NUzakelijk.nl  to use as a template for 

creating the advertorial. You must deliver the finished document as a JPG file. 

 
Teaser Box Styletoday.nl  

- Dimensions of entire creative: 320x110 pixels, GIF/JPG/PNG, 50kb max 
- Logo (image) to be used in this creative: 120x90 pixels 

- Title: 2 lines max, consisting of 12 characters per line, for a total of 24 characters (font type: 
Arial, font size: 14px, font weight: bold)  

- Body text: 3 lines max, consisting of 14 characters per line, for a total of 42 (font type: Arial, font 
size: 12px, font weight: regular) 

- Background colour: White  

- Text colour Grey, colour code: #8f8f8f 
- The word ‘Advertisement’ always appears in black in the bottom right, colour code: #000000 

- File size: 20kb Max 
 

Download the Photoshop document for the teaserbox at Styletoday.nl to use as a template for 
creating the teaserbox. You must deliver the finished document as a JPG file. 

 
Contact 

Do you have any material submission queries,? If so, please contact our Traffic department, at 
traffic@sanomamedia.nl or 020 840 4540. 

  



Sanoma Media Netherlands B.V.  

Mobile devices and tablets 

 

Mobile sites  

 
Banner (6:1) 

> 168x28 px, 25kb max 25kb, (ani)GIF, JPG, PNG)  

> 216x36 px, 25kb max 25kb, (ani)GIF, JPG, PNG)  

> 228x38 px, 25kb max 25kb, (ani)GIF, JPG, PNG)   
> 300x50 px, 25kb max 25kb, (ani)GIF, JPG, PNG)   
> 320x54 px, 25kb max 25kb, (ani)GIF, JPG, PNG) 

iPhone applications* 

Banner (6:1) 

> 320x54 px, 25kb max (GIF, JPG, PNG)  

> 640x108 px, 25kb max (GIF, JPG, PNG) 

 
Example (6:1) 

Double-sized banner (3:1) 

> 320x107 px, 25kb max (GIF, JPG, PNG)  
> 640x216 px, 25kb max (GIF, JPG, PNG) 

 
Example (3:1) 

Expandable banner 

> 320x54 px, 25kb max + 320x108 px, 25kb max (GIF, JPG, PNG)  
> 640x108 px, 25kb max + 640x216 px, 25kb max (GIF, JPG, PNG) 

Prestitial 
> 320x480 px, 25kb max (GIF, JPG, PNG)  

> 300x300 px, 25kb max (GIF, JPG, PNG) 

 
Advertorial banner 

> 165x106 px, 25kb max (GIF, JPG, PNG) + text (60 characters max) 

 
Example 
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Advertorial** 

> 120x120 px, 25kb max (GIF, JPG, PNG) + text 

* Animated GIFs cannot be served on iPhone applications. 

** Template available on request. 

 

Android applications* 
 

Banner (6:1) 

> 320x54 px, 25kb max (GIF, JPG, PNG)  

Double-sized banner (3:1): 

> 320x107 px, 25kb max (GIF, JPG, PNG) 

Prestitial 

> 320x480 px, 25kb max (GIF, JPG, PNG) 

 
Example 

Banner 

> 165x106 px, 25kb max (GIF, JPG, PNG) + text (60 characters max) 

Advertorial** 
> 120x120 px, 25kb max (GIF, JPG, PNG) + text 

* Animated GIFs cannot be served on Android applications. 

** Template available on request. 

 

Click to 

> Click to site/in-app browser  

> Click to app store/ ext-app browser  
> Click to video  

> Click to call  
> Click to send SMS (only for Nokia) 
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HTML5 

HTML5 banners are also be accepted. 

> HTML5 script must be tested on both Android and iPad/iPhone devices. 

> You must deliver a fully working script for which the files are externally hosted. 
For more information, contact your account manager. 

3rd party tags 
3rd party tags can be used.The material must be active when it is delivered. 

 

  

  

 
         

iPad 

 

Banners 

Nu.nl 
> 768x355 px (carrousel) 

> 300x250 px (medium rectangle) 
 

Viva.nl 

> 768x1004 px (portrait) 

> 1024x748 px (landscape)  
 

AutoWeek.nl 
> 768x1004 px (portrait) 

> 1024x748 px (landscape) 
> 768x355 px (carrousel)  

 
Advertorial banners 

> 366x170 px (landscape) 

> 180x300 px (portrait) 
 

Gamer.nl 
> 680x680 px (welcome ad). Also an option in an iPhone app, in which case, 300x300 px 

> 336x280 px (large rectangle) 
> 234x195 px (small rectangle) 

 
iPad material must be delivered as a still GIF or still JPEG (max 45kb). 

 
Landing site 

> 960x768 px (portrait) 
> 1024x704 px (landscape) 

 
It is preferred that all landing sites be built in HTML5. 
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Contact 
In addition to the standard services, customised deals are also available. Do you have any material 

submission queries? If so, please contact our Traffic department, at trafficmobiel@sanomamedia.nl 
and for tablets via traffic@sanomamedia.nl or 020 840 4540. 
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Layered ads 

These specifications outline the guidelines for delivering layered material for Sanoma Media sites. 

 

- A layer cannot be bigger than 100kb. 
- Deliver as SWF, Flash 8, ActionScript 2, 

- With clickTAG, embedded using the following code sequence:  
on (release) { getURL(_root.clickTag, "_blank"); }  

- Active URL, 

- Maximum dimensions for a layer of 500x400 pixels. 

- The layer must close automatically after a maximum of 10 seconds, at which point all running 
scripts must also stop. 

- Sound is only permitted if the visitor has the option of turning it On and Off with a soundbutton. 
- The layer must not cover the site’s logo or menu. 

- Layers cannot have 100% transparent backgrounds (maximum is 50%). 

- Each layer must have a clearly visible close button, placed in the upper right-hand corner of the 

layer which must be at least 15x15 pixels in size. The close button must include the word 'Close' 
and an ‘X’ in a different background colour than the website. It is preferred that the background 

colour of the close button be a shade of grey. 

 
The code for a close button is as follows: 

on (release) { 

getURL("javascript:dclk_hide()"); 

} 
Be sure that this code is placed in the button frame. 

- A layer can ostensibly be served in any of the available formats. 
- Layers cannot be served in a 1x1 pixel. 

Note: To prevent other layers from showing through the expandable, be sure to use the following 
parameters: 

w_mode = transparent (base format) and w_mode = opaque (expandable part) 
z-index for the base format = z-index=100 

Set the z-index for the layer as high as possible (z-index=999999999) 
 

A preloader of 15kb max is required for video & sound streaming that exceeds the maximum of 

100 kb. The weight of the video stream depends on the format and since we must examine that 
per advertisement, you need to contact us to discuss where the stream will be hosted.  

  
Designer’s contact information 

Please include the contact information for the layer’s designer when delivering the material. We 
always reserve the right to reject creatives if they do not comply with the stipulations and 

conditions set forth. 
 

Contact 
Do you have any material submission queries? If so, please contact our Traffic department, at 

traffic@sanomamedia.nl or 020 840 4540. 
 


